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РЕФЕРАТ 

Пояснительная записка 87 стр., 83 рис., 7 табл., 16 ист., 6 прил. 

NI MULTISIM 14.0, ЛАБОРАТОРНАЯ РАБОТА, ВЫПРЯМИТЕЛЬ, 

СТАБИЛИЗАТОР, ТРАНЗИСТОРНЫЙ УСИЛИТЕЛЬ, ГЕНЕРАТОР, 

АНАЛОГОВЫЕ УСТРОЙСТВА, ИСТОЧНИКИ ПИТАНИЯ. 

Объектом разработки являются лабораторные работы по дисциплинам 

«Основы компьютерного проектирования и моделирования 

телекоммуникационных систем», «Моделирование микроволновых 

устройств» адаптированные к новой программной среде. 

Цель работы – разработка цикла лабораторных работ «Моделирование 

аналоговых устройств» в программной среде NI Multisim. 

Выпускная квалификационная работа представляет собой часть 

разрабатываемого курса лабораторных работ. Указанный курс состоит из 

двух частей, одна из которых – «Моделирование аналоговых устройств», 

представленная в данной работе. Указанная часть лабораторного практикума 

является модернизированной версией методического пособия к 

лабораторным работам «Проектирование РЭС в пакетах OrCAD и Microwave 

Office». 

Целью данной работы была не только адаптация старого курса к новой 

программной среде, но и получения полезных навыков в области 

моделирования аналоговых устройств студентами факультета радиотехники 

и телекоммуникаций СПбГЭТУ «ЛЭТИ». 

 В данном курсе работ моделирование выполняется с помощью 

программного обеспечения - NI Multisim 14.0. ВКР содержит руководство по 

выполнению трёх лабораторных работ, для каждой из них подробно описан 

алгоритм действий выполнения работы и приведены теоретические 

выкладки. Результатом проделанной работы является часть нового 

методического пособия по моделированию аналоговых устройств в ПО NI 

Multisim 14.0.  
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ABSTRACT 

This paper is the part of a laboratory casebook and is devoted to the 

modeling of analog devices. It is a modernized version of the casebook for 

laboratory practices in the discipline "Basics of Computer Design and Modeling of 

Telecommunication Systems". 

As a result of the work, the manual was adapted to the new software 

environment - NI Multisim 14.0. The use of modern software will allow us to 

obtain new useful skills in modeling analog devices for students of the Faculty of 

Radio Engineering and Telecommunications of ETU “LETI” 
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ОПРЕДЕЛЕНИЯ, ОБОЗНАЧЕНИЯ И СОКРАЩЕНИЯ 

В настоящей пояснительной записке применяют следующие термины с 

соответствующими определениями: 

NI – National Instruments 

ВКР – выпускная квалификационная работа 

ОЭ – общий эмиттер 

ОБ – общая база  

ОК – общий коллектор 

ПО – программное обеспечение  

РЭС - радиоэлектронные средства 
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ВВЕДЕНИЕ 

Компьютерное моделирование стало важной составной частью 

проектирования электронных устройств. Программы схемотехнического 

анализа радиоэлектронных средств представляют собой виртуальные 

лаборатории, имеющие в своём составе библиотеки серийных электронных 

компонентов. Они позволяют инженеру проверить, удовлетворяет ли 

спроектированное им устройство требованиям технического задания, и 

отладить его перед изготовлением опытного образца. Многие программы 

дают возможность автоматизировать все стадии проектирования устройства, 

такие как подготовка принципиальных схем, моделирование различных 

процессов в аналоговых и цифровых цепях, компоновку и трассировку 

печатных плат, редактирование и расширение библиотеки компонентов. 

В настоящее время для студентов факультета радиотехники СПбГЭТУ 

«ЛЭТИ» разработан и успешно внедрен курс лабораторных работ 

«Проектирование РЭС в пакетах OrCAD и Microwave Office», автором 

которого является Головков А.А.[1].  

Существует большое количество пакетов схемотехнического анализа, 

схожих с указанным выше пакетом, например, Micro-CAP от Spectrum 

Software, McCAD EDA Tools, NI Multisim, Protel DXP и др. [2]. В связи с этим 

различные компании используют какой-либо конкретный пакет программ 

или несколько. Знание принципов работы и опыт разработки в нескольких 

средах моделирования становятся очевидным плюсом для соискателей, 

которыми являются выпускники СПбГЭТУ «ЛЭТИ». Также владение сразу 

несколькими специализированными пакетами позволяет сократить время 

разработки и повысить качество спроектированного устройства, путём 

подбора для конкретной задачи оптимального инструмента моделирования. 

Таким образом, для повышения ценности на рынке труда 

выпускающихся специалистов и развития профессиональных навыков 

студентов возникла необходимость адаптации существующего курса 
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лабораторных работ по схемотехническому моделированию к новому 

программному инструменту. 

Одним из современных пакетов, позволяющих моделировать 

электронные схемы, является NI Multism. Указанный набор программ 

обладает простым наглядным интерфейсом, содержит мощные средства 

анализа результатов моделирования. Данный продукт разработан известным 

производителем измерительного оборудования National Instruments [3]. В нем 

содержатся модели виртуальных измерительных приборов, копирующих 

реальные аналоги. Тесное сотрудничество с производителями электронных 

компонентов позволило собрать внушительную библиотеку: более чем 2000 

SPICE-моделей Analog Devices, Phillips, NXP и др. Таким образом, NI 

Multisim даёт возможность объединить процессы разработки электронных 

устройств и тестирование на основе технологии виртуальных приборов для 

учебных и производительных целей. 

Вышесказанное позволило сделать выбор в пользу NI Multisim в 

качестве инструмента для выполнения лабораторных работ. 

Целью работы является – модернизация методического пособия к 

лабораторным работам «Проектирование РЭС в пакетах OrCAD и Microwave 

Office» с помощью программного обеспечения - NI Multisim 14.0. ВКР 

содержит 3 лабораторные работы с подробно описанным алгоритмом 

действий и теоретические выкладки для каждого представленного объекта 

моделирования. Первая лабораторная работа посвящена моделированию 

источников питания. В данной работе необходимо подробно ознакомиться с 

такими устройствами как: выпрямитель и стабилизатор напряжения.  

Во второй лабораторной работе описываются различные методы 

моделирования транзисторного усилителя с последующим тестированием 

приборов, повторяющих реальные аналоги осциллографа, 

спектроанализатора и анализатора амплитудных и фазочастотных 

характеристик – Bode Plotter. 
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Лабораторная работа № 3 «Моделирование генераторов» содержит 3 

модели генераторов с различными способами возбуждения. Данная 

лабораторная работа способствует дальнейшему знакомству студента с 

виртуальными измерительными приборами и различными методами анализа. 

В конце каждого руководства к выполнению лабораторной работы 

представлен отчёт по выполнению данной работы, содержащий необходимые 

графики и таблицы. 
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ГЛАВА 1. ОБЗОР ЛИТЕРАТУРЫ. 

На сегодняшний день существует множество программ 

схемотехнического проектирования радиоэлектронных устройств, которые 

также обладают возможностью моделирования. Широкое применение в 

сфере схемотехнического анализа получили программы, такие как Micro-

CAP от Spectrum Software, McCAD EDATools, NI Multisim, Protel DXP и др.  

Рассмотрим некоторые из них. MicroCAP – система моделирования, 

предназначенная для анализа аналоговых, цифровых и смешанных аналого-

цифровых устройств [4]. Данная программа легко усваиваемая, за счёт 

удобного и простого интерфейса. Так же она не предъявляет завышенных 

требований к программно-аппаратным средствам ПК, что и делает её 

востребованной. В основном Micro-CAP пользуется спросом среди 

студентов, благодаря простоте в использовании. Более сложной 

автоматизированной системой, состоящей, из нескольких автономных 

программных модулей является система OrCAD [5]. Основными 

компонентами данной системы являются: графический редактор – Capture, 

графический редактор печатных плат – Layout и программа моделирования 

электронных устройств – PSpice. Наличие графического редактора - Layout, 

говорит о возможности трассировки печатных плат, которой лишена система 

MicroCAP. Система OrCAD может проводить несколько типов анализа схем, 

такие как анализ переходных процессов, фурье анализ, анализ внутренних 

шумов, параметрический анализ и др. Эти же самые типы анализа можно 

встретить в программе NI Multisim [6]. Она в свою очередь обладает высокой 

функциональностью, в отличие от MicroCAP, разработчики которой 

стремились к компромиссу между функциональностью и простотой, получив 

нечто среднее. Программа имеет на своём счету более 2000 компонентов 

мировых производителей, таких как Analog Devices, Phillips, NXP и др. 

Данная платформа отличается от вышеописанных программ 

схемотехнического анализа предоставлением возможности пользователю 

объединить процессы разработки электронных устройств и тестирование на 



13 

 

основе технологии виртуальных приборов. Необходимо так же выделить, что 

все перечисленные программы являются коммерческими и их легальные 

версии недоступны для многих учреждений ввиду большой стоимости. Но в 

2018 году у студентов факультета радиотехники СПбГЭТУ «ЛЭТИ» 

появилась возможность изучения программы NI Multisim, что вызвало 

необходимость адаптации к новой системе моделирования ныне 

существующего курса лабораторных работ «Проектирование РЭС в пакетах 

OrCAD и MicroWaveOffice», автором которого является Головков А.А. [1].  

В настоящее время изучением программного обеспечения NI Multisim, 

с последующей разработкой методических пособий к лабораторным работам 

в данной среде, занимались Б.Л. Резников, В.Н.Попов [7]. Методическое 

пособие содержит 4 лабораторные работы, первая из которых посвящена 

изучению схем на полупроводниковых диодах. В данной работе подробно 

рассматривается классификация полупроводниковых диодов, а так же 

принцип работы и методы моделирования основных типов схем 

выпрямительного устройства. В последних лабораторных работах 

приводится описания полевых и биполярных транзисторов, различных схем 

операционных усилителей и базовых логических элементов ТТЛ логики. 

Рассматриваемое методическое пособие в большей степени направлено на 

изучение принципов работы исследуемого устройства и его математического 

описания. В меньшей степени направленно на изучение типов анализ в 

используемой программной среде и их применения к исследуемым 

устройствам.  

Рассмотрению данного вопроса также был посвящен лабораторный 

практикум, авторами которого являются А.Л. Марченко, С.В. Освальд [8]. 

Данный практикум состоит из 4 лабораторных комплексов, содержащих 37 

лабораторных работ. В книге имеется описание схем исследуемых устройств, 

приведены краткие теоретические сведение, сформулированы задание на 

проведение экспериментов и даны рекомендации к их выполнению. Один из 

разделов учебного пособия выделен для изучения аналоговых электронных 
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приборов и устройств. Но данный раздел не содержит некоторых 

лабораторных работ, описанных в ВКР.  

Аналогичные задачи решал В.Б. Терехин [9]. Им было написано 

практическое руководство к лабораторным работам по курсу «Прикладная 

электроника» в среде разработки Multisim. Он содержит 7 лабораторных 

работ, полностью посвященных исследованию логических элементов, за 

исключением первого раздела, в котором подробно описан виртуальный 

осциллограф: назначение каждого компонента прибора, его внешний вид и 

предназначение. 

Также существует труд А.Н. Шестеркина, содержащий материал 

необходимый для освоения компьютерной системы моделирования и анализа 

схем NI Multisim [10]. Справочник состоит из 7 разделов. В первой главе 

описаны основные установки программы, которые необходимо определить 

перед началом работы. Для полного изучения возможностей программы 

написана вторая глава. Она создана в основном для начинающих 

пользователей, её изучение делает работу более эффективной. Полезными 

так же являются четвёртая и пятая главы, в которых кратко описаны 

виртуальные измерительные приборы и типы анализа радиоэлектронных 

устройств. 
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ГЛАВА 2. ЛАБОРАТОРНАЯ РАБОТА №1. 

МОДЕЛИРОВАНИЕ ИСТОЧНИКОВ ПИТАНИЯ 

2.1 Основные теоретические положения 

Источники электрического питания являются главной составной 

частью любого радиоэлектронного устройства, ведь без источника питания 

не станет работать ни одна схема. Для преобразования сетевого напряжения в 

необходимый потребителю постоянный или переменный ток, используются 

специальные устройства, такие как стабилизатор переменного напряжения, 

сглаживающий фильтр, трансформатор, выпрямитель. Рассмотрим некоторые 

из них. 

Выпрямитель – статическое устройство, необходимое для 

преобразования входного переменного напряжения в постоянное напряжение 

[11]. Диоды и тиристоры - приборы с односторонней проводимостью - лежат 

в основе выпрямителей. Именно они позволяют протекать току в 

нагрузочной цепи только в одном направлении, то есть, выпрямляют его. 

Схема выпрямителя также содержит силовой трансформатор и нагрузку. 

Силовой трансформатор – устройство, необходимое для повышения или 

понижения напряжения питающей сети. По типу схемы выпрямителей 

разделяют на однополупериодные, двухполупериодные со средней точкой, 

мостовые и схемы с умножением напряжения.  

Рассмотрим однофазную мостовую схему выпрямителя, изображенную 

на рисунке 2.1 

 

Рисунок 2.1 – Схема выпрямителя 
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Представленная схема состоит из четырёх диодов, включенных по 

мостовой схеме, источника синусоидального напряжения, трансформатора и 

выходной нагрузке. Характеристики, используемых диодов марки BAS21, 

приведены в приложении А. В одну из диагоналей моста включена выходная 

нагрузка, в другую – вторичная обмотка трансформатора. Общая точка 

катодов диодов D1, D2 представляет собой положительный полюс 

выпрямителя, а общая точка анодов диодов D3, D4 является отрицательным 

полюсом.  

Во вторичной обмотке трансформатора полярность напряжения 

меняется с частотой питающей сети. В данной схеме диоды работают парами 

поочерёдно. В момент прохождения положительного полупериода 

напряжения U2 проводят ток диоды D1 и D4, в отрицательный – ток 

проводят диоды D2 и D3. Ток нагрузки проходит постоянно в одном 

направлении. Т.к. на нагрузке выделяется два полупериода сетевого 

напряжения, схема выпрямителя - двухтактная. 

Стабилизатор напряжения – устройство, предназначенное для 

автоматической стабилизации выходного напряжения в узких пределах, при 

существенном изменении входного напряжения.  

В данной работе используется стабилизатор LM1084IS-ADJ/NOPB – 

низковольтный регулятор постоянного напряжения, способный регулировать 

выходное напряжения, даже если оно близко по значению к напряжению 

питания. Подробно его характеристики описаны в приложении Б. 

Стабилизатор имеет два входа. Вход IN предназначен для подключения 

напряжения питания, ADJ – регулируемый вход, используется для 

подключения опорного напряжения, равного 1.25 В, которое развивается 

между выходом и регулировочным штифтом стабилизатора. 

Рассматриваемый стабилизатор является понижающим: его выходное 

стабилизированное напряжение всегда ниже входного.  

В работе также предлагается провести измерения характеристик 

исследуемых устройств с помощью виртуального прибора – осциллографа.  
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2.2 Основные характеристики виртуального осциллографа 

- XSC1 

Осциллограф – прибор, необходимый для исследования амплитудных и 

временных характеристик электрического сигнала, подаваемого на его вход. 

Набор инструментов используемого пакета содержит двухканальный и 

четырёхканальный осциллографы. В данной лабораторной работе 

применяется двухканальный осциллограф, имеющий канал А и канал B 

(Channel A, Channel B) с раздельными регулировками чувствительности в 

диапазоне от 10мкВ/дел до 5 кВ/дел и смещения по вертикали (Y Position). 

Чувствительность каналов и положения изображений сигналов регулируются 

с помощью кнопок «увеличить» и «уменьшить», появляющиеся при щелчке 

по полю, где отображаются значения чувствительности и смещения. 

Информационные входы для каждого канала обозначены символом «+», 

символом «–» обозначены общие входы – «земля». 

На условном обозначении осциллографа отмечены несколько типов 

развёртки Y/T, Add, B/A, A/B. В основном используется режим Y/T – режим, 

при котором по вертикали отображается напряжение сигнала, по горизонтали 

с время. Режим Add необходим для воспроизведения суммы каналов А и В. В 

режиме B/A воспроизводится сигнал канала B по вертикали, по горизонтали 

– сигнал канала А. В случае использования режима A/B соответственно 

наоборот.  

В ждущем режиме (Trigger) запуск развёртки (Edge) может 

осуществляться по фронту или срезу запускающего сигнала при 

регулируемом уровне Level запуска, в режиме Auto (от канала A или B), от 

канала А, от канала В или от внешнего источника (Exit).  

Осциллограф снабжён двумя визирами (T1, T2), необходимыми для 

проведения измерений. Их положение оцифровывается – под экраном 

осциллографа для каждого визира отображаются значения напряжения и 

времени для каналов А и В. В строчке T1-T2 вычисляются значение разности 

времён и напряжений для моментов времени, определённых визирами. Для 
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управления визирами можно воспользоваться командами контекстного меню, 

которое вызывается щелчком по правой кнопке мыши.  

2.3 Моделирование выпрямителя 

1 Запустить программу NI Multisim 14.0. 

2 Используя набор библиотек программы NI Multisim 14.0, 

построить схему, показанную на рисунке 2.1. Для этого необходимо 

обратиться к библиотекам: 

 Sources, семейство SIGNAL_VOLTAGE _SOURCES и выбрать 

компонент АС_VOLTAGE – источник переменного 

синусоидального напряжения. В семействе POEWR_SOURCES 

выбрать компонент GROUND; 

 Basic, семейство RESISTOR и выбрать резисторы необходимых 

номиналов. В семействе TRANSFORMER выбрать компонент 

COUPLED_INDUCTORS; 

 Diodes, семейство SWITCHING_DIODE выбрать 4 компонента 

модели BAS21. 

3 Сохранить файл, присвоив ему подходящее имя с помощью 

команды File → Save as. 

4 Установить индикаторы напряжения на вход и выход устройства.  

5 Для получения графиков входного напряжения и напряжения на 

нагрузке выбрать в строке меню опцию Simulate → Analyses and Simulate, и 

установить тип анализа Transient. В поле Initial Conditions (начальные 

условия) из раскрывающегося списка выбрать User-defined (начальные 

условия, определенные пользователем). В поле TSTART(Start time) 

установить время начала анализа – 0 с. Время завершения анализа TSTOP – 

60мс. Здесь же выбрать вкладку output и задать необходимые переменные 

PR1, PR2. После установки параметров нажать кнопку Run. При отсутствии 

ошибок на экране появится график временной зависимости входного и 

выходного напряжения. 
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6 С помощью команды Cursor → Show cursors, установить курсор 1 

на максимум входного напряжения, курсор 2 установить на максимум 

выходного напряжения. Для точной установки курсоров можно 

воспользоваться командами контекстного меню, путём нажатия правой 

кнопки мыши на курсор и выполнить команду «Go to next YMAX». 

Зафиксировать результаты. Скопировать график можно с помощью команды 

Edit → Copy graph. 

7 Определить предельное значение входного сигнала для данного 

типа диодов, увеличивая его значение.  

8 Определить влияние на работу выпрямителя значения 

коэффициента трансформации, путём изменения индуктивности обмоток 

трансформатора. 

9 Последовательно с нагрузкой включить индуктивность. Для этого 

необходимо открыть библиотеку Basic, семейство INDUCTOR, выбрать 

индуктивность L = 1000мГн.  

10 Для исследования входного и выходного напряжения на 

осциллографе необходимо подключить его к схеме. Для этого выполним 

команду simulation → instruments → oscilloscope. Информационный вход 

канала А подключить к входной цепи, информационный вход канала В 

подключить к выходной. Вход с символом « - » подключить к земле. 

Подключение осциллографа к схеме, изображено на рисунке 2.2. 

 

Рисунок.2.2 – Схема выпрямителя с измерительным прибором 
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11 Запустить команду simulation → analyses and simulation и выбрать 

тип анализа Interactive analyses. Закрыть окно нажатием кнопки Save.  

12 Дважды левой кнопкой мыши нажать на подключенный к схеме 

осциллограф XSC1. В правом нижнем углу в секции Timebase выбрать режим 

развёртки – Y/T - режим, в котором по вертикали отображается напряжение 

сигнала, по горизонтали – время. В той же секции выбрать Scale – 10ms/Div. 

Чувствительность (Scale) и смещение по вертикали (Y Position) для обоих 

каналов подстраиваются так, чтобы графики было удобно исследовать на 

экране. Рекомендуется задать Chanal A Scale -100ms/Del. Chanal B Sscale – 

100ms/Del. В секции Trigger выбрать Single. Выбрать для каналов А и В тип 

развёртки – DC. После выполнения настроек осциллографа нажать кнопку 

Run.  

13 Выполнить измерения для канала А. Для этого установить тип 

развёртки канала В - . Установить курсор на максимум входного 

напряжения, для этого нажать правой кнопкой мыши на курсор и выполнить 

команду « Go to next Y MAX ». Зафиксировать результаты. 

14 Выполнить измерения для канала В. Зафиксировать результаты.  

Сравнить полученные результаты при моделировании схемы 

выпрямителя с использованием типа анализа – Transient и виртуального 

осциллографа.  

2.4 Моделирование стабилизатора напряжения 

1 Запустить программу NI Multisim 14.0. 

 

Рисунок 2.3 – Схема стабилизатора напряжения 
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2 Построить схему, показанную на рисунке 2.3. Для этого 

использовать библиотеки: 

 Sources, семейство POWER_SOURCES и выбрать два компонента 

DС_POWER – источник постоянного напряжения. В семействе 

POEWR_SOURCES выбрать компонент GROUND; 

 Basic, семейство RESISTOR, выбрать резистор необходимого 

номинала; 

 Power, семейство VOLTAGE_REGULATOR выбрать компонент 

LM1084IS-ADJ/NOPB. 

3 Установить значение напряжения V1 = 10В, V2 = 1.26В. 

Установить индикатор напряжения перед нагрузкой R1.  

4 Установить тип анализа DC Sweep. Для этого во вкладке Analysis 

parameters поставить галочку в поле Use source 2. Задать линейное изменение 

источника напряжения V1 в пределах от 0В до 29В с шагом 0,1В. Также 

задать линейное изменение источника постоянного напряжения V2 в 

пределах от 1,1В до 1,3В с шагом 0,1В. Нажать кнопку Run. 

5 Исследовать нагрузочную характеристику стабилизатора. Для 

этого необходимо использовать тип анализа – Parameter Sweep. Открыть 

вкладку Analysis parameters. В разделе Sweep parameters указать в поле 

Device Type (тип элемента) Resistor; name – R1; parameter – resistance. В 

разделе Point to sweep(закон изменения параметра) выбрать способ 

изменения параметра – Linear(линейный). Изменение параметра произвести в 

пределах от 100Ом до 1кОм с шагом 180Ом. В разделе More options 

(дополнительные возможности) из развёртывающегося списка выбрать 

режим исследования по постоянному току – DC Operating Point. Поставить 

галочку в поле Group all traces on one plot. Поставить галочку в поле Display 

resultson a graph.  

6 Выполнить моделирование. При отсутствии ошибок на экране 

появится семейство графиков стабилизированного напряжения.  
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2.5 Отчёт по лабораторной работе №1 

 

/Изъято согласно Заявлению/ 
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ГЛАВА 3. МОДЕЛИРОВАНИЕ ТРАНЗИСТОРНОГО УСИЛИТЕЛЯ. 

ЛАБОРАТОРНАЯ РАБОТА №2 

3.1 Основные теоретические положения 

Транзисторный усилитель – усилитель, основанный на применении 

транзисторов в качестве усилительных элементов [12]. Транзисторные 

усилители классифицируют по форме электрических сигналов как: 

 усилители постоянного тока – усилители непрерывных сигналов; 

 усилители переменного тока - усилители сигналов с несущим 

гармоническим процессом. Из них выделяют узкополосные или 

избирательные, усиливающие только одну гармоническую 

составляющую из ряда гармоник периодического тока; 

 импульсные усилители – широкополосные усилители 

импульсных сигналов; 

 усилители среднего значения тока – усилители, преобразующие 

изменение амплитуды или фазы гармонического сигнала в 

зависимости от изменения значения и знака постоянного тока  

Схемотехнику усилителей на транзисторах можно разделить на три 

основные схемы, именно они лежат в основе более сложных схем 

транзисторного усилителя: 

 усилитель с общим эмиттером (ОЭ); 

 усилитель с общей базой (ОБ); 

 усилитель с общим коллектором (ОК). 

Основной усилительный элемент – транзистор содержит три вывода, 

поэтому один из его выводов необходимо использовать одновременно для 

подключения источника сигнала и подключения нагрузки. Тогда получается, 

что схема с общим эмиттером является усилителем, где эмиттер транзистора 

используется как для подключения входного сигнала, так и для подключения 

нагрузки. 

Рассмотрим схему транзисторного усилителя с общим эмиттером, 

представленную на рисунке 3.1 
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Рисунок 3.1 – Схема транзисторного усилителя  
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3.2 Использование в работе анализатора спектра сигналов 

Спектроанализатор – прибор, предназначенный для измерения и 

отображения спектра исследуемого сигнала – зависимость амплитуд 

гармонических составляющих от частоты. [1313]. Условное обозначение 

прибора показано на рисунке 3.2. 

 

Рисунок 3.2 – Условное обозначение спектроанализатора 

Для проведения исследований необходимо подключить 

информационный вход прибора (IN)к источнику сигнала и задать настройки 

удобные для его исследования. Внешний вид прибора показан на рисунке 3.3. 

 

Рисунок 3.3 – Внешний вид спектроанализатора 

Для получения спектрограммы исследуемого сигнала необходимо 

выполнить настройки в поле Frequency: 

 указать контрольную частоту Span; 

 задать начальное (Run) и конечное (End) значение частот, после 

этого становится активна кнопка «Enter», при нажатии которой 

автоматически устанавливается среднее значение частоты 

(Center). 
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Для удобного восприятия результатов исследования в поле Amplituda 

подбирается: 

 масштаб, полученного изображения по амплитуде (Range); 

 способ представления амплитуд гармоник – линейный (Lin) в 

вольтах или логарифмический в децибелах. При выборе 

логарифмического способа представления есть возможность 

задать линию отсчёта (Ref); 

 разрешение прибора по частоте (ResolutionFreq). Минимальное 

значение разрешения по умолчанию составляет конечную 

частоту, деленную на 1024 – FFT Points. 

Можно изменить число точек, нажав кнопку Set, выбрав одно из 

значений раскрывающегося списка. В этом же диалоговом окне 

определяется:  

 источник синхронизирующих сигналов внешний (External) или 

внутренний (Internal); 

 способ синхронизации – Triggermode – непрерывным или 

одиночным сигналом (Continuous – Single); 

 Порог синхронизирующего сигнала (Threshold) 

В поле управления диапазоном исследуемых частот (Spancontrol) при 

выборе: 

 Zero Span (Центральная частота) пользователь может установить 

только среднюю частоту (Center); 

 Full Spen (Полный диапазон частот) гармоники определяются в 

диапазоне от 0 Гц до 4 МГц; 

 Set Span - все необходимые настройки задаются посредством 

выбора пользователя. 

Запускается анализатор кнопкой «Start» на лицевой панели прибора. С 

помощью визира, расположенного в левом верхнем углу, можно оцифровать 

значение амплитуды и частоты. 
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3.3 Моделирование транзисторного усилителя в частотной 

области 

1 Запустить программу NI Multisim 14.0. 

2 Построить схему, показанную на рисунке 3.1. Для размещения на 

рабочем поле графического образа источников напряжения необходимо в 

библиотеке sources семейства power_sources выбрать компонент DC_Power – 

источник постоянного тока и компонент AC_Voltage – источник переменного 

напряжения, принадлежащий семейству signal_voltage_sources. Конденсатор 

типа C, резистор типа R и индуктивность типа L находятся в библиотеке 

Basic. Биполярный транзистор типа Q2N2222A – в библиотеке Transistors, 

заземление типа GROUND – в библиотеке Sources. Для источника V1 задать 

амплитуду сигнала 3 В и частоту 2.2 МГц. 

3 Сохранить схему с помощью пункта меню File → Save As. 

4 Смоделировать схему по постоянному току в рабочей точке. 

5 Войти в режим управления моделированием и включить анализ 

по переменному току с помощью команды Simulate→ Analysis and Simulate 

→ AC Sweep и задать в его параметрах линейное изменение частоты от 10 Гц 

до 5 МГц. Установить индикатор напряжения (Voltage - V(PR1)) на нагрузку 

усилителя (резистор R5). 

6 Установить индикатор напряжения V(PR2) на вход цепи. 

Выполнить команду Simulate → Analysis and Simulate → AC Sweep, открыть 

вкладку output и нажать кнопку Add expression. В появившемся окне диалога 

Analysis Expression в поле Expression задать отношение выходного и 

входного напряжения. Нажать кнопку Run.  

7 При отсутствии ошибок, появится семейство частотных 

характеристик входного, выходного и их отношения. Выполнить команду 

Cursor → Show cursors. Появятся два визира, установить один из них на 

максимальное значение амплитуды отношения входного и выходного 

напряжения. Результат зафиксировать.  
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8 Нажав правой кнопки мыши на график ФЧХ, установить визир на 

фрагмент кривой соответствующий частоте 2.2МГц. Результат 

зафиксировать. 

9 Изучить режим модификации параметров элементов. Для этого 

выполнить команду Simulate → analyses and simulate → Parameter 

Sweep.Окно диалога Parameter Sweep содержит три раздела. В разделе Sweep 

parameters в поле Sweep parameters из развёртывающегося списка выбрать 

Device parameter. В поле Device type – Resistor, Name – R5, Parameter – 

resistance. В разделе Points to sweep задать линейное изменение глобального 

параметра R5 в диапазоне от 50 Ом до 1 кОм через 200 Ом; 

10 Изучить режим анализа шумов. Установить маркер напряжения 

на коллектор транзистора. Выполнить команду Simulate → analyses and 

simulate → Noise. В первой вкладке Analysis Parameters задать в качестве 

выходного напряжения (Output Voltage) напряжение на коллекторе 

транзистора V(Q1:c), а в качестве внешнего источника - источник V1. Для 

этого в поле Input noise reference source выбрать - V1, output node - V(PR2). 

Во вкладке Frequency parameters задать настройки анализа переменного тока 

AC Sweep, для этого необходимо нажать кнопку Reset to main AC values. Во 

вкладке output задать onoise для всех элементов и нажать Run. 

11 Для исследования вклада элементов схемы в выходной шум 

указать во вкладке output на необходимость вывода графиков суммарной 

спектральной плотности выходного шума onoise_spectrum и спектральной 

плотности шумов элементов onoise_rr1, onoise_rr2, onoise_rr3, onoise_rr4. 

12 Удалить график, соответствующий элементу, вносящему 

наименьший вклад в шумовые характеристики схемы. 

13 Выполнить команду Simulate → analyses and simulate → 

Interactive Simulation. Закрыть диалоговое окно нажатием кнопки Save. 

14 Изучить прицеп работы виртуального анализатора амплитудных 

и фазочастотных характеристик – Bode Plotter. Для размещения прибора на 

рабочем поле выполнить команду Simulate → Instruments → BodePlotter. 



29 

 

Левые клеммы подключить к входам исследуемой цепи, правые подключить 

к выходам.  

15 Измерить АЧХ исследуемого сигнала. Нажатием кнопки 

Magnitude, воспроизвести на экране прибора амплитудную характеристику 

исследуемого устройства. Установить диапазон частот в окне параметров 

Horizontal. От начальной частоты (Initial= 3 mHz) до конечной (Final = 

3MHz). В поле Vertical установить минимальное (I=0) и максимальное (F=5) 

значение коэффициента передачи. Установить по горизонтали и вертикали 

линейный масштаб – Lin. С помощью визира измерить значение амплитуды 

соответствующее частоте сигнала 2.2МГц и зафиксировать его. 

16 Измерить ФЧХ исследуемого сигнала. Нажатием кнопки Phase, 

воспроизвести на экране прибора фазовую характеристику исследуемого 

устройства. Установить диапазон частот в окне параметров Horizontal. От 

начальной частоты (Initial = 3 mHz) до конечной (Final = 3 MHz). В поле 

Vertical установить минимальное (I=-720º) и максимальное (F=720º) 

значение. Установить по горизонтали и вертикали линейный масштаб – Lin. 

С помощью визира установить максимальное значение фазы соответствующе 

частоте сигнала 2.2МГц и зафиксировать его. 

17 Сравнить полученные результаты с помощью моделирования 

схемы транзисторного усилителя при использовании типа анализа – AC 

Sweep и при использовании виртуального анализатора амплитудных и 

фазочастотных характеристик – Bode Plotter. 

3.4 Моделирование переходных процессов 

1 Построить схему, показанную на рисунке 3.1. 

2 Сохранить схему с помощью пункта меню File → Save As. 

3 Войти в режим управления моделированием с помощью команды 

Simulate → Analysis and Simulate, включить моделирование переходных 

процессов Transient и задать в его параметрах время моделирования Final 

Time 3 мкс. Установить индикаторы напряжения на вход и выход усилителя. 
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4 Выполнить моделирование командой Run. При отсутствии 

ошибок на экране появится временные зависимости входного и выходного 

напряжения. Измерить, полученные графики с помощью курсоров. 

Результаты зафиксировать. 

5 Выполнить команду Simulate → Analysis and Simulate → 

Transient, открыть вкладку output и с помощью кнопки Add добавить ток 

коллектора. Входное и выходное напряжение удалить с помощью кнопки 

Remove. Закрыть диалоговое окно нажатием кнопки Run. Проанализировать 

полученные результаты и определить режим работы транзистора. 

6 Выполнить преобразование Фурье для данных графиков и 

получить их спектральное представление. Для этого выполнить команду 

Simulate → Analysis andSimulate → Fourier. Установить разрешение по 

частоте (Frequency resolution) 2.2МГц, число, вычисляемых гормоник-20. 

Время, в течение которого будет производиться дискретизация – 2мкс. В 

поле Display в раскрывающемся списке выбрать опцию Chart and Graph. 

Выбрать масштаб, используемый при воспроизведении амплитуда (фазы)–

линейный. Во вкладке output указать в поле Selected variables for analysis 

входное напряжение или индикатор напряжения (PR1).  

7 При отсутствии ошибок на экране появится спектрограмма и 

таблица анализа гармонических составляющих. Экспортировать таблицу, 

выполнив команду Tools→Export to Excel. Сохранить график, выполнив 

команду Edit → Copy Graph.  

8 Выполнить п .6, п.7 для выходного напряжения и для тока 

коллектора. 

9 Удалить индикаторы напряжений, и установить индикатор тока 

между конденсатором C2 и индуктивностью L1. Выполнить команду View → 

Circuit Parameters. В правом нижнем углу в поле Name задать имя 

глобального параметра. Нажав дважды на источник синусоидального 

напряжения в поле voltage также указать имя глобального параметра. 

Выполнить команду Simulate → analyses and simulate → Parameter Sweep. В 
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разделе Sweep parameters в поле Sweep parameters из развёртывающегося 

списка выбрать Circuit Parameter. Parameter – имя глобальной переменной. 

Тип анализа – Transient, время анализа – 2мкс. Способ изменения параметра 

выбрать линейный. Изменять от 0 до 3 с шагом 0.5. 

10 Выполнить моделирование. На экране появится семейство 

переходных процессов при разных амплитудах входного воздействия. 

Зафиксировать результат. 

11 Для исследования входного и выходного напряжения на 

осциллографе необходимо подключить его к схеме. Для этого выполним 

команду simulation → instruments → oscilloscope. Информационный вход 

канала А подключить к входной цепи, информационный вход канала В 

подключить к выходной. Вход с символом « - » подключить к земле. 

Подключение осциллографа к цепи, изображено на рисунке 3.4. 

 

Рисунок 3.4 – Схема транзисторного усилителя с осциллографом  

12 Дважды левой кнопкой мыши нажать на подключенный к схеме 

осциллограф - XSC1. В правом нижнем углу в секции Timebase выбрать 

режим развёртки – Y/T – режим, в котором по вертикали отображается 

напряжение сигнала, по горизонтали – время. В той же секции выбрать Scale 

500ns/Div. Чувствительность (Scale) и смещение по вертикали (Y Position) 
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для обоих каналов подстраиваются так, чтобы графики было удобно 

исследовать на экране. Рекомендуется задать Chanal A Scale - 2V/Del. Chanal 

B Scale – 2V/Del. В секции Trigger выбрать Single. Выбрать для каналов А и 

В тип развёртки – DC. После выполнения настроек осциллографа нажать 

кнопку Run и Start на лицевой панели прибора. 

13 Выполнить измерения для канала А. Для этого установить тип 

развёртки канала В - . Установить курсор на максимум входного 

напряжения, для этого нажать правой кнопкой мыши на курсор и выполнить 

команду « Go to next Y MAX ». Зафиксировать результаты. 

14 Выполнить измерения для канала В. Зафиксировать результаты.  

15 Сравнить полученные результаты с помощью моделирования 

схемы транзисторного усилителя при использовании типа анализа – Transient 

и при использовании виртуального осциллографа.  

16 Для исследования спектра входного сигнала использовать 

виртуальный измерительный прибор – Анализатор спектра. Выполнить 

команду simulation → instruments → Spectrumanalyzer. Информационный 

вход IN подключить к входной цепи, вход T подключить к земле. 

Подключение анализатора спектра к схеме, изображено на рисунке 3.5. 

17 Выполнить настройки спектроанализатора. Для этого задать Span 

– 2МГц, диапазон частот от 2МГц до 5МГц, средняя частота – 2.5МГц, 

масштаб изображения по амплитуде – 0,5V/Del. Способ представления 

амплитуд гармоник – линейный (Lin), разрешение прибора по частоте 

(Resolution Freq) - 15,925кГц. С помощью визира измерить амплитудное 

значение гармонической составляющей на частоте 2.2МГц. Результаты 

зафиксировать.  
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Рисунок 3.5 – Схема транзисторного усилителя с осциллографом и 

спектроанализатором  

18 Повторить п.15, п.16 для исследования выходного сигнала. 

Результаты зафиксировать.  

19 Сравнить полученные результаты с помощью моделирования 

схемы транзисторного усилителя при использовании типа анализа – Fourier и 

при использовании виртуального анализатора спектра. 

3.5 Моделирование влияния разбросов параметров 

1 Построить схему, показанную на рисунке 3.1. 

2 Сохранить  схему с помощью пункта меню File → Save As 

3 Установить индикатор напряжения на нагрузку транзисторного 

усилителя. Включить режим моделирования по переменному току и 

выполнить его в диапазоне от 10Гц до 5МГц, число точек – 10000. Тип 

развёртки и вертикальный масштаб выбрать линейный. Во вкладке output 

выходная переменная задана по умолчанию – V(PR1). После выполнения 

настроек, нажать кнопку Run. 

4 Установить для всех резисторов предел разброса сопротивления 

TOLERANCE равным 10% на схеме, дважды нажав на необходимый 
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компонент. С помощью команды Simulate → analyses and simulate включить 

режим статистического анализа Monte-Carlo.Во вкладке TOLERANCE с 

помощью кнопки Add tolerance добавить в поле tolerancelist поочерёдно все 

резисторы, имеющиеся в схеме. Задать в поле tolerance value – 10%, в поле 

Description из раскрывающегося списка выбрать UNIFORM (равномерное 

распределение). Во вкладке Analysis parameters указать: 

 число статистических испытаний – 10; 

 тип анализа – AC. Далее слева нажать кнопку Edit analysis 

в появившемся окне нажать кнопку Reset to main AC 

values, закрыть окно нажатием кнопки ОК;  

 выходную переменную – выходное напряжение – V(PR1). 

5 Выполнить моделирование. На экране появится график семейства 

статистических характеристик выходного напряжения и таблица 

статистического анализа. Сохранить графики и экспортировать 

результирующую таблицу в Excel.  

6 Повторить п.4, п.5, изменив вид распределения в поле Description 

на Gaussian. Выполнить моделирование. Зафиксировать, полученные 

результаты.  

7 Выполнить расчет оценки наихудшей комбинации значений 

параметров. Для этого в окне параметров режима указать: 

 способ анализа – метод Worst Case; 

 тип анализа – AC, выходная переменная – выходное 

напряжение – PR1; 

 направление отклонения от номинала – вверх (High); 

 разброс параметров сопротивлений – 10%. 

8 Выполнить моделирование. На экране появятся две частотные 

характеристики выходного напряжения – для номинальных значений 

параметров и для наихудшей комбинации при максимальных, в пределах 

разброса, значениях всех параметров. Зафиксировать результаты. 
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9 Повторить п.7, п.8, изменив направление отклонения от номинала 

Low (вниз). Зафиксировать результаты.  

3.6 Отчёт по лабораторной работе №2 

 

/Изъято согласно Заявлению/ 
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ГЛАВА 4. МОДЕЛИРОВАНИЕ ГЕНЕРАТОРОВ. 

ЛАБОРАТОРНАЯ РАБОТА № 3 

4.1 Основные теоретические положения 

Генератор – устройство, которое преобразует механическую энергию, 

полученную из внешнего источника, в электрическую энергию.  

В данной лабораторной работе будут рассмотрены такие генераторы 

как:  

 Мультивибратор 

 Генератор Колпитца 

 Кварцевый генератор на инверторах  

Мультивибратор – генератор прямоугольных импульсов, работающий 

в режиме автогенератора. Схема мультивибратора основана на двух 

транзисторах или логических схемах с дополнительными элементами. 

Можно сказать, что мультивибратор представляет собой двухкаскадный 

усилитель с цепью положительной обратной связи. Благодаря наличию 

положительной обратной связи усилитель превращается в генератор. 

Существуют симметричные и несимметричные мультивибраторы.  

Рассмотрим симметричный мультивибратор, показанный на рисунке 

4.1 

 

Рисунок 4.1 – Схема мультивибратора  

Номиналы элементов каждого из двух плеч симметричного 

мультивибратора совпадают: R1=R4, R2=R3, C1=C2. На осциллограмме 

выходного сигнала симметричного мультивибратора можно легко заметить, 
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что прямоугольные импульсы и паузы между ними равны. Его работа 

основана на зарядно-разрядных процессах конденсаторов, которые вместе с 

резисторами образуют RC- цепочки.  

Генератор Колпитца или LC-генератор – является одной из схем 

генераторов, использующих комбинацию индуктивности и ёмкости для 

определения частоты. 

Рассмотрим генератор Колпица собранный на операционном 

усилителе, показанный на рисунке 4.2 

 

Рисунок 4.2 – Генератор Колпитца 

Использование в работе LC-генератора позволяет получить 

высокочастотные синусоидальные колебания. Они возникают за счёт LC-

контура, который настроен на определенную частоту и подключен к 

усилительной схеме, чтобы обеспечить необходимое усиление на его 

резонансной частоте. Петля обратной связи применяется для поддержания 

колебаний на резонансной частоте колебательного контура LC. В схему 

включен операционный усилитель марки LM324N – четырёх ядерный 

операционный усилитель, работающий при напряжении питания до 3В. 

Подробно его технические характеристики описаны в приложении Г. 

Кварцевый генератор – автогенератор, предназначенный для 

получения колебаний фиксированной частоты, в состав которой входит 
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кварцевый резонатор. На рисунке 4.3 представлена схема кварцевого 

генератора на инверторах. 

 

Рисунок 4.3 – Кварцевый генератор на инверторах 

Главным элементом схемы является кварцевый резонатор марки HC-

49U_7MHz. Его основные характеристики описаны в приложении Д. Он 

предназначен для стабилизации и выделения электрических колебаний 

определенной частоты. Стоит отметить, что кварцевый резонатор имеет 

лучшие характеристики, чем другие приборы для стабилизации частоты, 

такие как стабильность по частоте и температуре. Ещё одним важным 

элементом схемы являются инверторы марки 7404N, характеристики 

которых описаны в приложении Е, предназначенные для изменения фазы 

выходного сигнала на 180º относительно входного.  

4.2 Моделирование мультивибратора 

1 Запустить программу NI Multisim 14.0. 

2 Построить схему, показанную на рисунке 4.4. Для этого 

необходимо, используя библиотеки Sources, Basic, Transistors расположить 

элементы типа – Pulse_Voltage – генератор прямоугольных импульсов 
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напряжения; R –резисторы с номиналами 1k, 100k,750; C – конденсаторы с 

номиналами 0.01uF; 2Q2222A – два биполярных транзистора. Элемент ground 

также находится в библиотеке Source. Установить индикаторы PR1, PR2, 

PR3. 

 

Рисунок 4.4 – Схема мультивибратора с импульсным источником  

3 Сохранить схему с помощью пункта меню File → Save As. 

4 Проверить при какой несимметрии появляются возбуждения, 

уменьшая значение резистора R5. Для этого воспользуемся типом анализа – 

TransientAnalysis. Выполнить команду Simulate → analyses and simulate → 

Transient. Из раскрывающегося списка « начальные условия » выбрать « 

Calculate DC operating point » (начальные условия устанавливаются на основе 

расчёта рабочего режима по постоянному току). Время моделирования – 5мс. 

Во вкладке output в поле Selected variables for analysis по умолчанию 

установлены индикаторы V(PR1), V(PR2), V(PR3). 

5 Выполнить моделирования. На экране появятся график 

временных зависимостей напряжений в точках установки индикаторов 

V(PR1), V(PR2), V(PR3). 
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6 Уменьшая значение резистора R5, добиться появления 

возбуждений. Результаты зафиксировать. 

7 После подбора значения сопротивления R5, измерить амплитуду 

установившихся колебаний с помощью курсоров. Результаты зафиксировать.  

8 Выполнить команду Simulate → analyses and simulate → 

Interactive Simulation. Закрыть диалоговое окно нажатием кнопки Save. 

9 Подключить осциллограф к схеме. Для этого выполнить команду 

simulation → instruments → oscilloscope. Информационный вход канала А 

подключить к точке установки индикатора V(PR1), информационный вход 

канала В подключить к точке установки индикатора V(PR3). Вход с 

символом « - » подключить к земле. 

10 Дважды левой кнопкой мыши нажать на подключенный к схеме 

осциллограф -XSC1. В правом нижнем углу в секции Timebase выбрать 

режим развёртки Y/T - режим в котором по вертикали отображается 

напряжение сигнала, по горизонтали – время. В той же секции выбрать Scale  

200us/Div.Чувствительность (Scale) и смещение по вертикали ( YPosition) для 

обоих каналов подстраиваются так, чтобы оба графика было удобно 

исследовать на экране. Рекомендуется задать Chanal A Scale - 5V/Del. Chanal 

B Sscale – 5V/Del. В секции Trigger выбрать Single. Выбрать для каналов А и 

В тип развёртки – DC.После выполнения настроек осциллографа нажать 

кнопку Run.  

11 Выполнить измерения напряжения V(3). Для этого установить 

тип развёртки канала В - . Установить курсор на максимальное значение 

амплитуды напряжения, для этого нажать правой кнопкой мыши на курсор и 

выполнить команду « Go to next Y MAX ». Зафиксировать результаты. 

12  Выполнить измерения напряжения V(5). Зафиксировать 

результаты. 

4.3 Моделирование генератора Колпитца. 

1 Запустить программу NI Multisim 14.0. 
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2 Построить схему, показанную на рисунке 4.2. Для этого 

обратимся к библиотекам:  

 Sources, выберем источники постоянного тока - DC_Power с 

номиналами (V1=12V, V2=12V, V3=-1.535); GROUND;  

 Analog, выберем операционный усилитель Opamp – LM324N;  

 Basic, выберем резисторы Resistors (R1 = 2K, R2= 2k, R3=500), 

конденсаторы Capacitor (C1=0.05, C2=0.005) и катушку 

индуктивности Inductor (L1=5mH). 

3 Войти в режим управления моделированием с помощью команды 

Simulate → Analysis and Simulate, включить моделирование переходных 

процессов Transient и задать в его параметрах время моделирования End Time 

800 мкс.Установить индикаторы напряжения Voltage на указанные в схеме 

точки. 

4 Выполнить моделирование. При отсутствии ошибок на экране 

появится график временной зависимости напряжений V(PR1), V(PR2). 

Результаты зафиксировать. 

5 Увеличивая значение напряжения источника V(3) в пределах от -

1.535V до 1.535V, исследовать изменение поведения кривых V(PR1), V(PR2). 

Результаты зафиксировать. 

4.4 Моделирование кварцевого генератора на инверторах 

1 Запустить программу NI Multisim 14.0. 

2 Построить схему, показанную на рисунке 4.3. Для этого выбрать 

следующие библиотеки и компоненты: 

 Mick, семейство CRYSTAL и выбрать компонент - HC-

49/U_7MHz; 

 TTL, семейство 74STD, компонент - 7404N; 

 Source, семейство Signal_Voltage_Sources, компонент – 

Pulse_Voltage; 

 Basic, семейство Resistor, компоненты – R1 = 10k, R2 = 0.1k; 

 Basic, семейство CAPACITOR, компонент -С1 = 30pF; 
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 Sources, компонент GROUND. 

3 Сохранить схему с помощью пункта меню File → Save As. 

4 Войти в режим управления моделированием с помощью команды 

Simulate → Analysis and Simulate, включить моделирование переходных 

процессов Transient и задать в его параметрах время анализа End Time 2 

мкс.Установить индикаторы напряжения Voltage на схему в соответствие с 

рисунком 4.3. Выполнить моделирование. При отсутствии ошибок на экране 

появится график временной зависимости напряжений V(PR1), V(PR2). 

5 С помощью курсоров, измерить периоды     напряжений в точках 

V(PR1), V(PR2). Результаты зафиксировать.  

6 Для данных графиков выполнить преобразование фурье и 

получить их спектральное представление. Для этого выполнить команду 

Simulate → Analysis and Simulate → Fourier. Установить разрешение по 

частоте (Frequency resolution) 100кГц, число вычисляемых гормоник - 300. 

Время, в течении которого будет производиться дискретизация – 2нс. В поле 

Display в раскрывающемся списке выбрать опцию Graph. Выбрать масштаб, 

используемый при воспроизведении амплитуда (фазы)–линейный. Во 

вкладке output указать в поле Selected variables for analysis индикатор 

напряжения (PR1).  

7 При отсутствии ошибок на экране появится спектрограмма 

индикатор напряжения (PR1). Измерить с помощью курсоров частоту 

сигнала     Сохранить график, выполнив команду Edit → Copy Graph и 

показание курсоров.  

8 Повторить п.6, п.7 для индикатора напряжения (PR2). 

Зафиксировать результаты. 

9 Внимательно изучить показание курсоров (п.5 и п.7). Проверить 

выполняется ли условие:   = 
 

  
, где   – частота сигнала,   - период 

сигнала. 
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4.5 Отчёт по лабораторной работе  

 

/Изъято согласно Заявлению/ 
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ГЛАВА 5. БЕЗОПАСНОСТЬ ЖИЗНЕДЕЯТЕЛЬНОСТИ  

Темой данной ВКР является «Разработка цикла лабораторных работ по 

моделирование аналоговых устройств». Она подразумевает под собой 

проектирование  и моделирование схем исследуемых устройств с помощью 

программы NI Multisim. Результатом работы является часть методического 

пособия, в которой представлено руководство по выполнению трёх 

лабораторных работ.  Все лабораторные работы выполняются с помощью 

персонального компьютера. Выполнение каждой из них, в лучшем случае, 

рассчитано на пару академических часов, в зависимости от успеваемости 

студента. Известно, что при длительном использовании компьютера, он 

становится источником вредного воздействия на здоровье человека и, как 

следствие, источником профессиональных заболеваний. Для того чтобы 

уменьшить пагубное воздействие вредных факторов, необходимо соблюдать 

меры защиты, оговоренные в разделах БЖД.  

Безопасность жизнедеятельности – наука, подразумевающая под собой 

выполнения ряда правил, направленных на сохранения здоровья и создания 

комфортной рабочей среды. Целью изучения безопасности 

жизнедеятельности  является формирования свода правил, направленных на 

снижение потерь здоровья людей от внешних факторов окружающей среды.   

5.1 Опасные и вредные производственные факторы 

Для попытки исключения вредоносных факторов, нужно определить 

какие из них возникают, при длительной работе за компьютером. Стоит сразу 

отметить психофизические опасные факторы [1414]. К ним относятся 

физические и нервно-психические перегрузки. Они проявляются в виде 

умственного напряжение, перенапряжения зрительных и слуховых 

анализаторов, возникают эмоциональные перегрузки. Появлению утомления 

способствуют изменения в центральной нервной системе, возникающие при 

работе, что способствует снижению производительности труда. Кроме того 

долгое пребывание в одном и том же положение вызывает статическое 
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напряжение. Через некоторое время в клетках напряженной группы мышц 

запускается процесс торможения – клетки привыкают и стремятся 

поддерживать такое состояние. В результате развиваются болезни такие, как 

остеохондроз, грыжа межпозвоночных дисков, искривление позвоночника. 

Наличие вредных факторов, уровни которых превышают принятые 

нормативы для допустимых условий труда, согласно документу [1515], 

соответствующие третьему классу второй степени вредности, оказывают 

неблагоприятное воздействие на здоровье пользователя. 

5.2  Эргономика взаимодействия человек-система. 

Принципы организации диалога 

 В настоящем стандарте организация диалога интерпретируется как 

установка взаимодействия между человеком и интерактивной системой, 

подразумевая воздействия пользователя на систему и получения от неё 

ответной реакции для достижения установленных целей. 

В стандарте установлено семь основных эргономических принципов 

создания интерактивной системы:  

 приемлемость организации диалога для выполнения 

производственного задания; 

 информативность; 

 соответствие ожиданиям пользователя; 

 пригодность для обучения; 

 контролируемость; 

 устойчивость к ошибкам; 

 адаптация к индивидуальным особенностям пользователя. 

5.2.1  Приемлемость организации диалога для выполнения 

производственного задания 

Необходимо, чтобы интерактивная система соответствовала 

производственному заданию. В качестве интерактивной системы выступает 

система анализа NI Multisim. В соответствие с требованиями 
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производственного задания на выходе необходимо получить требуемую 

информацию в виде графиков и таблиц, что удовлетворяет возможностям 

диалоговой системы. Это означает, что в процессе диалога пользователь 

получает информацию об успешном завершении задания. В данной 

программе предусмотрена поисковая система, которая освобождает 

пользователя от избыточной информации, тем самым ограничивая его от 

излишней умственной нагрузки. Поисковая система способна определять 

искомый компонент схемы по названию, типу, марки и.т.д. Это экономит 

время. Формат ввода и вывода соответствует производственному заданию. 

Значение типовых настроек в программе устанавливается по умолчанию, что 

облегчает выполнения производственного задания. Использование «горячих 

клавиш» даёт дополнительные возможности пользователю при выполнении 

повторяющихся длинных команд. Система предусматривает также установку 

«горячих клавиш» на любую комбинацию команд необходимую 

пользователю для минимизации промежуточных этапов.  

5.2.2  Информативность 

На любом этапе диалога информация, представленная пользователю, 

способствует завершению диалога. Этому свидетельствует наличие команды 

«применить», «отменить», «согласиться» при выполнении настроек. 

Программа NI Multisim содержит пункты меню, которые описывают 

характерные задания пользователя, поддерживаемые пакетом программ. 

Задавая определённый тип анализа, программа отображает все необходимые 

этапы, выполнение которых способствует получению результатов 

моделирования. В пакете присутствуют значки, изображающие аппаратное 

управление: «Run», «Pause», «Stop», с их помощью осуществляется 

управление процессом моделирования. Программа предоставляет 

пользователю информацию о единицах измерения, что показано на рисунке 

5.1. 
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Рисунок 5.1 – Окно основных характеристик источника напряжения 

5.2.3  Соответствие ожиданиям пользователя 

Соответствие ожидаемого диалога определяется посредствам его 

предсказуемости и соответствия с принимаемым соглашением. ПО NI 

Multisim использует терминологию проектировщика, что удовлетворяет 

требованием данного принципа. Установка обратной связи между 

пользователем и диалоговой системой  проявляется в виде результатов 

моделирования. Пакет содержит европейский и американский стандарты, 

соответствующие культурным и лингвистическим соглашениям. 

Пользователь может выбрать любой из двух. Расположение кнопок команд 

«Ок» и «Отмена» соответствуют привычным для пользователя позициям. 

При размещении компонентов на рабочем поле и их последующее 

соединение можно прервать нажатием кнопки «Esc». В случае некорректного 

ввода информации для сохранения файла, появляется сообщение об ошибке. 

Это означает, что обратная связь, предоставляемая пользователю, 

представлена в объективном стиле.  

5.2.4  Пригодность для обучения  

Программа содержит раздел «Help», имеющийся во всех диалоговых 

окнах. Он описывает, как необходимо выполнять задания с помощью пакета 

программы. Это позволяет создать собственный шаблон и более 
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эффективный способ для запоминания информации. Обратная связь помогает 

пользователю в формировании понимания изучаемой программы. Она 

подсказывает пользователю все действия, требуемые для получения 

результатов моделирования. ПО NI Multisim даёт возможность пользователю 

имитировать этапы диалога без отрицательных последствий. Это 

подтверждается наличием кнопки «Отмена», позволяющей отменить 

последовательность действий, влияющих на результаты моделирования. 

Можно сделать вывод, что программа, рассмотренная выше полностью 

соответствует требованием ГОСТ Р ИСО 9241-110-2016. 

5.3 Эргономика взаимодействия человек-система. 

Элементы графического пользовательского интерфейса 

Необходимо установить взаимосвязь методов ввода и графических 

элементов интерфейса пользователя.  

Работа пользователя с графическими элементами интерфейса 

осуществляется с помощью различных способов ввода, использующих 

следующие приёмы:  

 ввод данных с клавиатуры; 

 указания с помощью компьютерной мыши, ручки, распознавания 

жестов, отслеживание положения глазного яблока; 

 речевой ввод с использованием голосовых команд, 

распознавания голоса;  

Программа NI Multisim наделена двумя способами ввода информации, 

такими как ввод данных с клавиатуры и указания с помощью компьютерной 

мыши. Программа предоставляет пользователю возможность использовать 

оба метода. Для того чтобы использовать в качестве инструмента ввода 

информации клавиатуру, требуется чёткая визуализация места ввода, где 

происходит взаимодействие, что и показано на рисунке 5.2. 
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Рисунок 5.2 – Ввод информации с помощью клавиатуры 

При использовании способа указания необходимо визуальное 

отображение указателя для определения виртуального положения 

устройства, что представлено на рисунке 5.3. 

 

Рисунок 5.3 – Ввод информации с помощью компьютерной мыши 

В программе встречаются графические элементы интерфейса, такие как  

 гармошка – соединение нескольких развёртываемых секций, 

каждая из которых представляет собой группу элементов 

пользовательского интерфейса; 

 слайдер – элемент интерфейса пользователя, позволяющий ему 

подбирать значение из непрерывного диапазона; 

 карусель – набор элементов, отображаемых в круговом 

расположение, способствующие перемещению вперёд-назад; 

 чек-бокс – элемент, используемый для выбора варианта, который 

может находиться в двух состояниях «положительное» или 
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«отрицательное» с подписью и индикатором, указывающим 

выбран параметр или нет. 

Программа содержит все вышеперечисленные компоненты полностью 

удовлетворяющие требованием ГОСТ Р ИСО 9241-161-2016. 

5.4 Эргономика взаимодействия человек-система. 

Руководство по индивидуализации программного обеспечения 

Индивидуализация рассматривается как изменение поведения 

интерактивной системы во время её использования для обеспечения 

наиболее подходящих условий эксплуатации для отдельного пользователя. 

Она подразумевает организацию таких изменений, которые не требуют 

перепрограммирования пакета в виду уже встроенных возможностей 

индивидуализации.  

Программа NI Multisim обладает некоторыми возможностями 

индивидуализации для удовлетворения требований пользователей, 

относящихся к различным категориям. Пользователь на своё усмотрения 

может изменить стандарт символа, выбрать язык ввода английский или 

немецкий, размер шрифта, цветовую гамму. Также он может располагать 

панель инструментов на рабочем поле или скрывать её. Расположение 

кратких характеристик компонентов также регулируются.  

Все вышеперечисленные возможности программы свидетельствует 

тому, что ПО NI Multisim полностью удовлетворяет требованием ГОСТ Р 

ИСО 9241-129-2014. 

Для того чтобы сделать процесс работы студентов более 

эргономичным, в выпускной квалификационной работе были описаны 

методы упрощения работы в исследуемой среде разработки. Они включали в 

себя замену сложных команд, для выполнения определенного действия, на 

альтернативные команды, реализация которых может значительно 

сэкономить время. 
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В данном разделе были рассмотрены психофизические факторы, 

отрицательно влияющие на здоровье пользователя и причины их 

возникновения. Так же было установлено полное соответствие ПО NI 

Multisim с требованиями, описанных выше стандартов. Программа имеет 

интуитивно понятный интерфейс, пригодный для реализации поставленной 

задачи. 
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ЗАКЛЮЧЕНИЕ 

Целью работы являлась разработка цикла лабораторных работ по 

дисциплинам «Основы компьютерного проектирования и моделирования 

телекоммуникационных систем», «Моделирование микроволновых 

устройств». Фактически необходимо было модернизировать методическое 

пособие к лабораторным работам «Проектирование РЭС в пакетах OrCAD и 

Microwave Office» с помощью программного обеспечения – NI Multisim 14.0. 

В ходе выполнения работы были изучены принципы создания схемы 

устройства в NI Multisim, различные тип анализа исследуемых устройств: 

анализ переходных процессов, Фурье анализ, анализ по переменному току, 

статистическое моделирование и др. Также были рассмотрены различные 

группы базовой библиотеки элементов схем. Для каждой лабораторной 

работы были разобраны примеры применения виртуальных измерительных 

приборов для получения характеристик исследуемых устройств. 

В результате написания ВКР разработан цикл лабораторных работ 

«моделирование аналоговых устройств». Цикл содержит в себе 3 

лабораторные работы: «Моделирование источников питания», 

«Моделирование транзисторного усилителя», «Моделирование генераторов». 

Для каждой из работ описан подробный алгоритм действий по выполнению. 

Приведены возможные формы отчётов, содержащие результаты 

моделирования в виде графиков и таблиц. Полученные результаты 

моделирования полностью соответствуют теоретическим сведением. Таким 

образом, цели ВКР достигнуты, поставленная задача выполнена. 
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